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1. Introduction to Kernel for OST to PST 

Welcome to the user manual for Kernel for OST to PST software, the most efficient and user-friendly email 
migration software that helps in migrating emails and other items from .OST file to .PST file. Apart from the 
functionality to convert.OST file data and save it as a PST file, software also provides supportive saving 
options to save converted file items in .EML, .MSG and .DBX files. 

1.1  Using this Manual 

This user manual is intended to guide System Administrators – a novice and/or experienced with complete 
working of Kernel for OST to PST software. We suggest that first time users should read this user manual 
completely and carefully before proceeding to use the software. However, if you are an experienced user, 
you can use the table of contents to find out information pertaining to the tasks that you need to perform 
by using Kernel for OST to PST. You can use the table of contents to navigate through different sections 
of this user manual. The table of contents lists all the contained sections in chronological order. The user 
manual comprises the following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Converting an OST file to a PST file 

 Full Version 

 Software Updates and Support 

 Troubleshooting 

 Glossary 

 Legal Notices 

Certain acronyms have been used throughout this manual. For clear understanding of the contents of this 
user manual, please go through the list mentioned below, before reading the manual. 

1.1.1 List of Acronyms 

OST or .OST: Offline Storage Files 

PST or .PST: Personal Storage Files 

EML or .EML: Electronic Mail (Outlook Express) 

DBX or .DBX: Email Folder (Outlook Express) 



                          

RTF or .RTF: Rich Text Format 

MS: Microsoft 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 

1.2  About Kernel for OST to PST 

Kernel for OST to PST is email migration software for Offline Storage Files created with MS Outlook. 
Software comprises of several advanced features such as four saving formats for converted .OST file 
items with strong and effective conversion and recovery engine which exports and restores more 
efficiently. 

Kernel for OST to PST conversion software helps to export .OST file items to .PST file or .DBX, .EML and 
.MSG file(s). It also recovers those emails which have been permanently deleted from the „Deleted Items‟ 
folder from the user mailbox. Multi-purpose email migration software, which will export as well as recover, 
deleted emails. 

Offline Storage Files or .OST files generally become inaccessible due to improper functioning of MS 
Exchange Server because of server downtime, database corruptions, virus contaminations and oversized 
and corrupt files (2GB file size). 

OST files get affected due to these mentioned errors and create problems at the time of downloading of 
emails and other items in user mailbox at his/her workstation. Inaccessible exchange server stops 
communicating or transmitting to user accounts where the user faces inaccessibility to any new received 
emails and recently archived items. 

Kernel for OST to PST helps to export emails, contacts, calendars, journals, appointments, tasks, events, 
attachments, embedded images, attached images, email properties (To, CC, BCC, Subject, From), date 
and time, email text formatting, Unicode characters, RSS Feeds, Drafts, Journals, and Personal folder 
items from the user mailbox existing in .OST files. It also recovers emails which have permanently deleted 
from the “Deleted Items” folder of the user mailbox. 

Kernel for OST to PST software scans the .OST file and lists the file contents in original folder hierarchy, 
which exists in .OST file. Preserved folder hierarchy helps to obtain better accessibility and readability of 
the listed items. Preview of items can be viewed in the right panel of the software where complete email 
data is displayed. The listed file items assure successful conversion of OST file items to .PST/ .DBX/ .EML 
or .MSG files. Recovered emails, which have deleted permanently are recovered and listed in the Deleted 
Items folder. View preview and select the folders which are to be saved in the desired file format. 

Due to its quick email scanning, and conversion capabilities, Kernel for OST to PST is considered as the 
ultimate solution for email migration requirements for MS Exchange Server. 

Saving options provided by Kernel for OST to PST software enables you to save .OST file items as .PST, 
.EML, .MSG or .DBX, depending on your migration requirements. 



                          

1.3 Salient Features 

Kernel for OST to PST enhanced features makes it the best available software for .OST file conversion. 
Salient features of the software are: 

1. Accurate and reliable export of email and other items from .OST file to .PST file. 

2. Recovery of permanently deleted emails from the Deleted Items folder. Recovery of complete 
email data, attachments, and images, text formatting and other properties associated with 
recovered emails. 

3. Restores original formatting of emails contained in the .OST files, where emails are recovered, 
migrated and saved in Plain Text, RTF and HTML format. 

4. Software features powerful data search engine that generates scan result, which are faster and 
more accurate. 

5. It provides preview in a tree like structure that enables the user to analyze the search results 
conveniently before converting the .ost file items to any desired file format. 

6. Software offers four saving options –.PST, .EML, .MSG, .DBX to save emails, which provides 
greater viewing and accessibility flexibility with the desired email client. 

1.4  About the Email Client File System 

Before moving further to discuss migration from .OST files to .PST files, it is important to understand 
various file systems that are related to worldwide used email client software. The most popular email client 
software for Windows based computers are: 

 MS Outlook 

 Outlook Express 

MS Outlook uses .msg files for storing emails. One .msg file corresponding to each email message is 
created and stored on the computer. To store large number of messages, MS Outlook creates a .pst file, 
which is a database file used for collective storage of emails associated with MS Outlook. MS Outlook also 
supports offline mode of working. These ost files store emails, calendars, appointments, drafts, 
attachments etc. in offline storage format. However, MS Outlook cannot be used to access .ost files and a 
MS Exchange account is required to access an .ost file. 

Offline Storage Files are also referred as .OST files; these files allow users to work in offline mode with 
exchange mailbox. Users can work without exchange connectivity and can perform functions like email 
composing, updating contacts and calendar events, scheduling meetings etc. Once the mailbox gets 
connected with the exchange server, recently performed actions automatically synchronize with Microsoft 
Exchange Server and updates are made to server side objects. 

 It is necessary to have MS Outlook configured and synchronized with an Exchange 
Server account to use .OST files. 



                          

Outlook Express uses .eml files to store email messages and one .eml file is created for each email 
message associated with Outlook express. To collectively store email messages in a database, Outlook 
Express uses .dbx files. 

1.5 Who Should Use this Software? 

The OST to PST conversion capability of Kernel for OST to PST Conversion makes this software 
preferred choice of system administrators, who handle email migration task in an organization. 

Kernel for OST to PST eases the conversion of .ost files to.pst files. Therefore, if you want to migrate ost 
file items to an accessible file format like pst, dbx, eml or msg, then you should use Kernel for OST to PST 
to scan convert the OST file into a .pst file. 



                          

2. Getting Started 

Now that you have understood the features and potential of Kernel for OST to PST, you are ready to get 
hands on experience of the software. To start the process of .ost to.pst conversion, first of all you will first 
need to download and install the software. However it is strongly recommended that before installing 
Kernel for OST to PST, you should go through the installation pre-requisites for the software to ensure that 
your system is properly configured to run the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for OST to PST can be broadly classified into 
two major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor  

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the converted files 

 You should have at-least 5 GB of free disk space if you want to convert and save 5 
GB.OST file into .PST file. 

2.1.2 Software Requirements: 

The software requirements for installing Kernel for OST to PST can further be grouped into two categories 
– Operating System Requirements and MS Exchange Server Requirements. The requirements are as 
follows: 

2.1.2.1 Operating System Requirements 

Supported Operating Systems: 

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 



                          

2.1.2.2 MS Exchange Server Requirements 

Supported versions of MS Exchange Server: 

 MS Exchange Server 2007 

 MS Exchange Server 2003 

 MS Exchange Server 5.5 

 MS Exchange Server 5 

2.1.2.3 MS Outlook Requirements 

 MS Outlook 2007 

 MS Outlook 2003 

 MS Outlook 2000 

 MS Outlook 98 

 MS Outlook 97 

2.1.2.4 Outlook Express Requirements 

 MS Outlook Express 6.0 

 MS Outlook Express 5.5 

 MS Outlook Express 5.0 

2.2 Downloading Kernel for OST to PST for the First Time 

After checking your computer with the prescribed system requirements for Kernel for OST to PST, you can 
download and install the software on your computer. You can buy the full version of software from any of 
our authorized resellers– Element5, Asknet and 2CO. 

If you want to try Kernel for OST to PST before buying it, then download the evaluation version from the 
following link: 

http://www.nucleustechnologies.com/download-ost-pst-conversion.php 

You can scan the .ost files saved on your system by using the evaluation version of Kernel for OST to 
PST; however, you will need to purchase full version of the software to save ost file items and utilize the 
available saving options i.e. PST, .EML, .MSG and .DBX. 

2.3 Installing Kernel for OST to PST 

http://www.nucleustechnologies.com/download-ost-pst-conversion.php


                          

After downloading the installer file for Kernel for OST to PST, you can install the software by running the 
file. To install the software: 

1. Double-click Kernel for OST to PST installer. Follow the on-screen instructions 

The Setup Installation Complete screen will be displayed. 

2. Click Finish, the main window of Kernel for OST to PST software will be launched. 

2.4 Launching Kernel for OST to PST 

If you did not launch the software after installing it, follow these steps to launch it later: 

To launch Kernel for OST to PST: 

Click Start  All Programs Kernel for OST to PST 

Alternatively, you can launch Kernel for OST to PST by double-clicking the shortcut icon available on the 
desktop and system tray (if enabled during setup installation). 

2.5 Uninstalling Kernel for OST to PST 

You may need to uninstall and re-install Kernel for OST to PST for reasons like activation to full version. 
To uninstall Kernel for OST to PST: 

1. Click Start  All Programs Kernel for OST to PST  Uninstall Kernel for OST to PST 

A warning message before un-installing will be displayed on the screen. 

2. Click Yes to uninstall Kernel for OST to PST. 

 Before proceeding to uninstall Kernel for OST to PST, you must ensure that the 
software is not running on your computer. 

Kernel for OST to PST will be successfully uninstalled from your system. 



                          

3. Software Interface 

Now that Kernel for OST to PST has been installed on your computer, you can start using the software 
after getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for OST to PST comprises three main menus – File, Tools, and Help. 

 

 

Figure 3.1: Menu-bar 

3.1.1 File Menu 

The File menu comprises three menu items. 

 

Figure 3.2: Menu-items of File menu 

Option Button Description 

Repair Lists the .OST file for conversion 

Save Displays save options to save the OST file 
contents 

Exit Close Kernel for OST to PST conversion 

3.1.2 Tools Menu 

The Tools menu comprises five menu items. 



                          

 

Figure 3.3: Tools menu 

Option Description 

Standard Check or Uncheck to hide or show standard tool 
bar in Kernel for OST to PST conversion software 

Status Bar Check or Uncheck to hide or show the Status Bar 

Theme Shows available themes like Office 2000 Theme, 
Office 2003 Theme and Office XP Theme, to 
change the Graphical User Interface. 

Live Update Updates the version of Kernel for OST to PST 
conversion with latest version available on 
Nucleus Data Recovery server. This process 
comes into effect when there is an updated 
version of the Kernel software available. 

Debug Mode Generates a log file for Kernel software. You can 
send this log to Nucleus Support if in any case 
you need help related to the Kernel software. 

3.1.3 Help Menu 

The Help menu comprises three menu items. 

 

Figure 3.4: Help menu 

Menu items in the Help menu: 



                          

Option Description 

Help View User Manual of Kernel for OST to PST 
Conversion 

Buy Online  Purchase the software online from website 

About Kernel OST to 
PST 

View version and support information of Kernel for 
OST to PST Conversion 

3.2 Tool-bar 

The tool-bar in Kernel for OST to PST is displayed below the menu-bar. The tool-bar provides a 
convenient and user-friendly method to perform certain actions that are also available in the menu-bar. 

 

Figure 3.5: Tool-bar 

Option Button Description 

Repair Lists the OST file for conversion 

Save Opens save options window to select the saving 
format 

Live Update Updates the version of Kernel for OST to PST 
conversion with latest version available on 
Nucleus Data Recovery server. This process 
comes into effect when there is an updated 
version of the Kernel software available. 

Help View User Manual of Kernel for OST to PST 
Conversion 

Buy Online Purchase the software online from website 

  



                          

3.3 Left Panel 

Whenever you browse and select an .ost file for conversion and click Scan, the screen gets divided into 
two panels: left panel and the right panel. 

 

Figure 3.6: Left Panel 

The left panel displays the email folders contained in the .ost file in a hierarchical tree like structure. You 
can click any of the folders available in the left pane to view its contents in right panel. 

3.4 Right Panel 

The right panel of the Kernel for OST to PST interface is divided into two halves. 



                          

 

Figure 3.7: Right Panel 

The top pane of the right panel displays the contents of the folder selected in the left panel. If you select 
any item from top pane of the right panel, a preview of that item will be displayed in the bottom pane. 

3.5 Buttons Used 

Apart from the standard options available in the menu-bar and the tool-bar, two buttons – Browse and 
Scan are displayed on the main window. The Browse button, which is placed at the center of the main 
window, enables you to browse and select the .ost file that needs to be converted into .pst file format. 

The Scan button is available at the bottom-right corner of the main window. Whenever you browse and 
select an .ost file for conversion, you need to click the Scan button to start the scanning process and get 
preview of the contents of the file before converting it to a .pst file. 

When scanning starts, two buttons Back and Save are displayed at the bottom-right corner of the main 
window. 

Option Description 

Scan Scans the OST file and preview its contents 

Back To go to the previous screen 

Save Saves the converted file 



                          

4. Converting .OST File to a .PST File 

Now that you have got acquainted with the user interface of Kernel for OST to PST, you are ready to 
convert an .ost file into a .pst file. 

4.1 Select and Scan .OST File 

To convert an .ost file into a .pst file, first of all you need to select and scan the file that needs to be 
converted. 

To select and scan a file: 

1. Launch Kernel for OST to PST. Click Browse and select the desired .ost file. 

2. Click Scan to start scanning the file. 

 

Figure 4.8: Main window of Kernel for OST to PST 

4.2 Preview Scanned File Items 

You can preview the contents of an .ost file before converting it into a .pst file to ensure accuracy of the 
emails and email data for conversion. 

To preview a file; 



                          

1. Select the parent folder of the file from the left pane. 

2. Select the file from the top panel of the right pane. 

The preview of the file will be displayed in the bottom panel of the right pane. 

 

Figure 4.9: Preview of listed emails and other items 

4.3 Save as .PST 

To convert an .ost file into a .pst file, you will need to save the .ost file items in .pst format. To save a file 
as a .pst file, select the appropriate folders from left pane: 

1. Click Save.  

2. Select the Save as PST (Microsoft Outlook) radio button. Click Save. 

3. Browse and select the desired location for saving the .pst file and click OK. 

 The saving functionality is not available in the evaluation version of Kernel for OST to 
PST. However, you can preview the contents of .ost file in evaluation version, but for 
saving it you will need to buy the full version of Kernel for OST to PST. 



                          

4.4 Save as .EML 

To save the selected file as an .eml file, select the appropriate folders from left pane: 

1. Click Save. 

2. Select the Save as EML (Outlook Express) radio button. Click Save. 

3. Browse and select the desired location for saving the file and click OK. 

4.5 Save as .MSG 

To save a file as .msg file, select the appropriate folders from left pane: 

1. Click Save. 

2. Select the Save as MSG (Microsoft Outlook) radio button. Click Save. 

3. Browse and select the desired location for saving the file and click OK. 

4.6 Save as .DBX 

To save a file as a .dbx file, select the appropriate folders from left pane: 

1. Click Save. 

2. Select the Save as DBX (Outlook Express) radio button. Click Save. 

3. Browse and select the desired location for saving the file and click OK. 



                          

 

Figure 4.10: Save options in Kernel for OST to PST 

  



                          

5. Full Version 

Although you can use Kernel for OST to PST evaluation version for free and can experience the 
capabilities of the software, but there are certain features that are not available in the evaluation version. 

5.1 Requirement of Full Version 

By using the evaluation version of Kernel for OST to PST, you can scan an .ost file and preview its 
contents but you cannot convert the .ost file into a .pst file. To convert the .ost file into a .pst file or any 
other desired file format, you will need to buy Full version of the software. 

5.2 Purchasing Full Version 

You can buy the full version of Kernel for OST to PST from any of our authorized resellers – Element5, 
Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for OST to PST and activation details of the 
software. 

5.3 Upgrading to Full Version 

If you are using the evaluation version of Kernel for OST to PST, you can upgrade to the full version by 
clicking Buy Online from the tool-bar. Alternatively, you can also upgrade to the full version by selecting 
the Buy Online option from Help menu of the menu-bar. 

  



                          

6. Software Updates and Support 

To attain maximum benefits from the capabilities of Kernel for OST to PST, you should always ensure that 
you have the latest version of the software. 

6.1 Upgrading to the Latest Version 

To upgrade to the latest version of Kernel for OST to PST, you will need to perform the following steps: 

1. Click Tools Live Update to launch the Live Update Window. 

2. Click Start to download the latest software updates. Alternatively, you can also launch the Live 
Updates window by clicking Live Update in the tool-bar. 

6.2 Help and Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for OST to PST. 

Software comes with an embedded help manual that can be accessed by clicking HelpHelp in the 
menu-bar or by clicking Help in the tool-bar. You can also press the F1 key on the keyboard of your 
computer to access the embedded help of Kernel for OST to PST. 

You can access the online help for Kernel for OST to PST at 

http://www.nucleustechnologies.com/Online-Helps.html 

We also have live support wherein you can chat with our software experts at 

http://www.nucleustechnologies.com/Support.html 

To talk on phone with our software experts call: 

Helpline: 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com


                          

7. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for OST to PST. 

7.1 Common Issues 

Why does Kernel for OST to PST have limits in evaluation copy? 

Free evaluation version of Kernel for OST to PST software enables you to experience the capabilities of 
the software. 

To convert and save the file items, you will need to buy the Full version of Kernel for OST to PST. 

Can I install the software on the same drive which contains the .ost file that I want to convert? 

Do not install Kernel for OST to PST on the same drive which contains the .ost file that you want to 
convert because your emails may get overwritten during the conversion process. 

Is the software available on the CD-Rom or the Floppy disks? 

Yes, Kernel for OST to PST is available on CD-ROM. Generally, we deliver our software online 
http://www.nucleustechnologies.com/Buy-Data-Recovery-Software.html 

But if you want software through Media (CD-ROM, Floppy disks) you have to specify it in your order email. 
You have to pay the shipping charges. 

7.2  Frequently Asked Questions 

How can I upgrade the software? 

To upgrade the software you have to send an email to sales@nucleustechnologies.com Please include 
your name, address, email address, order confirmation number and the name of the software you want to 
upgrade to. 

How to Buy Kernel for OST to PST? 

You can buy Kernel for OST to PST online at http://www.nucleustechnologies.com/Buy-Data-Recovery-
Software.html 

I have lost my full version for Kernel for OST to PST. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

Is my online order safe?  

Yes, you get the most secure and safest ordering option to buy your software Kernel for OST to PST from 
Nucleus Data Recovery.com. We never share your personal information with third parties.  

http://www.nucleustechnologies.com/Buy-Data-Recovery-Software.html
mailto:sales@nucleustechnologies.com
mailto:sales@nucleustechnologies.com


                          

8. Legal Notice 

This section comprises the legal specification about Kernel for OST to PST and the company NUCLEUS 
DATA RECOVERY.COM PRIVATE LIMITED 

8.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel, accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed; however, with respect to the use of the information contained herein.  

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

8.2 Trademark 

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, MS Outlook, and MS-DOS are registered 
trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

8.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

8.4 License Agreement 

Nucleus Kernel for OST to PST Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of 



                          

each Licensed Copy of Nucleus Kernel for OST to PST. For purposes of this License, if you have a valid 
license, you have the right to use a single Licensed Copy of Nucleus Kernel. 

Scope of License 

Each Licensed Copy of Nucleus Kernel for OST to PST may either be used by a single person or used 
non-simultaneously by multiple people who use the software personally installed on a single workstation. 
All rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You may not rent, 
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, 
Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus Kernel available 
to others in connection with a service bureau, application service provider, or similar business, nor permit 
anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Nucleus Kernel for OST to PST, and any and all accompanying software, files, data and materials, are 
distributed and provided AS IS and with no warranties of any kind, whether expressed or implied. In 
particular, there is no warranty for the quality of data recovered. You acknowledge that good data 
processing procedure dictates that any program, including Nucleus Kernel, must be thoroughly tested with 
non-critical data before there is any reliance on it, and you hereby assume the entire risk of all use of the 
copies of Nucleus Kernel covered by this License. This disclaimer of warranty constitutes an essential part 
of this License. In addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 
authorize you or anyone else to use Nucleus Kernel for OST to PST in applications or systems where 
Nucleus Kernel for OST to PST failure to perform can reasonably be expected to result in a significant 
physical injury, or in loss of life. Any such use is entirely at your own risk, and you agree to hold 
NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED harmless from any and all claims or losses 
relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 
Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED of any other or future violation of the same provision, or any other provision, of this License. 


